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Quick intro to Outpost
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Overview
Outpost Packet Message Manager

What is Outpost?
• A Windows-based packet messaging client

• Supports ARES, RACES, and other amateur radio emergency response
teams and their need to pass digital traffic

• Helps automate the packet message handling environment

• Manages all message-handling between you and the BBS

• Lets you read, delete, create, reply to, or forward messages back to the BBS
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Overview
Outpost Packet Message Manager

Why use Outpost?
1. Leverages the existing packet hardware, network, and BBS 

infrastructure
• Uses your existing TNC and packet radio equipment
• Compatible with many existing BBSs and TNC PBBSs
• Only your packet client (end-user program) changes

2. Hides the complexity of the packet operating environment
• Similar look and feel to contemporary email programs
• Shorter learning curve for packet operations
• Allows users to… “focus on the message, not the medium”

3. Implements most local emergency management policies for digital 
communications

4. Still under active development based on user requests and on-going 
alignment with the Outpost mission
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Overview
Outpost Packet Message Manager

Mission

The Outpost Packet Message Manager program supports the 
Emergency Communications Packet User community with a 
contemporary amateur radio packet messaging client that allows 
users to focus on the message, and not the medium.

Goal

Help get local ARES/RACES teams on the air with digital 
messaging using their existing hardware and BBS infrastructure.
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Overview
Outpost Packet Message Manager

Feature highlights
• Message support

• Private, NTS, and Bulletin messages
• Text formatting in a free-form message window
• NTS Message Maker with ARL message support
• On-line report builder

• Send/Receive Session (connection) control
• Serial, AGWPE, and Telnet interfacing with over 20 PBBS and BBSs
• Controls connecting, sending messages to and retrieving messages from the BBS

• Configurations and Setups
• BBS, TNC, and Interface configurations
• message type and retrieval options
• supports 3 ways for automatically initiating send/receive sessions
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Overview
Outpost Packet Message Manager

Message support
• Familiar email-app look & feel
• Separate folders for message 

storage
• Clear message identification 

(unread=BOLD, urgent=Red)
• Formal message workflow
• BBS and interface setups
• Additional settings control 

how Outpost behaves



9 Packet Radio and Emergency Communications with Outpost

Overview
Outpost Packet Message Manager

Creating Messages
• Supports Private, Bulletin, 

and NTS message types
• Message formatting before 

sending
• Set messages to Urgent
• Request delivery or read 

receipts
• Different ways for originating 

messages
• NTS Message Maker
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Overview
Outpost Packet Message Manager

Viewing messages
• Supports viewing, printing, 

deleting or saving a message 
to a local file

• Reply and Forward message 
formatting
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Interface How-Tos

1. AGWPE Setup
2. Telnet Setup
3. Telnet Setup with Winlink
4. TNC Command File
5. TNC Setup

BBS/PBBS How-Tos

1. BBS Setup
2. BBS Setup for Santa Clara County RACES
3. Connecting to a local KPC3/KPC9612 PBBS
4. Connecting to a local KPC3/KPC9612 PBBS
5. Connecting to a local MFJ-127X PBBS
6. Connecting to a local PK-232/DSP-232 PBBS
7. Using KA-Node/Netrom (BPQ) Access

Messaging How-Tos

1. Acknowledge Read, send automatically
2. Add a Signature
3. Annunciation
4. Automatic Retrieval
5. Create a message
6. Drag and Drop
7. Forwarding/Replying
8. Numbering messages
9. Online reports
10. Online reports, one-touch loading
11. Printing automatically
12. Requesting Delivery and Read Receipts
13. Retrieving selected bulletins
14. Send as Urgent
15. Sending a text file

Miscellaneous How-Tos

1. Enhanced Channel Monitoring
2. Scripts
3. Tactical Calls
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What’s new since 2007



What’s new since EmCommWest’07?
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v2.2c205 (14-May-2007) to present
• 90 enhancements and defect changes, including…

1. Enhanced BBS support

2. Various message and control improvements

3. Improved Comm Port support

4. Enhanced Channel Monitoring

5. Scripting 

6. Opdirect & PacForms

All release details are up at www.outpostpm.org
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1. Enhanced BBS Support  
Current list of supported BBSs (January 2009)

PBBSs
(TNC Firmware-based)

BBSs
(Software-based)

Support requested 
and pending

KPC2, KPC3, KPC3+
KPC9612
KAM, KAM-XL, KAM-98, 
KAM Plus, KAM-4
Data Engine (Kantronics)
PK-88, PK-232
DSP-232 
MFJ-1270x, -1278

AA4RE
DXNET
F6FBB
HAMSERV
JNOS, SNOS, TNOS
MSYS
N0ARY
NNA
Winlink: RMS & CMS
W0RLI

Kenwood D-700*
MFJ-1274
MFNOS*
PK-96*
OpenBCM

* Recently added

•See http://www.outpostpm.org/bbs/ for...
•Updates to the list of supported BBSs
•Instructions on how to get your BBS supported

http://www.outpostpm.org/bbs/
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Overview
Outpost Packet Message Manager

Types of controls
• Controls the flow of Send/Receive Sessions 
• Sets how messages are created and handled
• Set various data fields to automatically 

populate on-line reports and messages
• Set up default directory names
• Various log settings
• Outpost Scripting
• Form sizing controls
• Separate Interactive Packet Windows for… 

• Serial TNCs
• AGWPE
• Telnet
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2. General controls 
Recent Changes

Send/Receive Settings
• Selects different ways to automate the 

message send/retrieve sessions

• Select message types to be retrieved
• New Expanded Filters

• What to do with received messages

• Additional controls (Other Tab) 
manage printing messages, 
Alerts, and other controls 
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2. General controls 
Recent Changes

Message Settings
• Settings for new messages, includes

• New NTS handling, Msg Labels
• Default destinations
• Auto message numbering
• Add a Signature

• Handling replies and forwards 

• Set defaults for requesting 
message receipts

• Setting for permanently deleting 
messages 
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3. Improved Comm Port support
Recent Changes

#682: Adds TNC Initialization file 
capability. Allows the user to define a 
list of TNC commands to be sent to 
the TNC both prior to a BBS connect 
and immediately after a disconnect.

#720: Identifies and shows all virtual 
Comm Ports. Identifies exactly what 
comm ports exist.

#607: Adds capability for Ipserial.exe 
to export a current interface 
configuration to Outpost.  
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4. Enhanced Channel Monitoring  
Recent Changes

The Problem
1. Users want to monitor the packet channel 

in between Outpost sessions
2. However, 2 apps cannot access a comm 

port at the same time

The Solution
1. Run Ipserial.exe; from Outpost, select 

Tools > Interactive Packet > 
Serial/Comm Port.

2. From Ipserial.exe, Tools > Options, then 
check the box titled "Turn on Packet 
Monitoring (MON ON) on serial port 
connect".  Press OK.

3. When Outpost runs Send/receive, it …
(i)  first tells Ipserial.exe to disconnect
(ii) runs Send/Receive Session, then, 
(iii) tells Ipserial.exe to reconnect
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5. A tour of Outpost Scripting
Recent Changes

The problem
1. Users have requested additional capabilities with Outpost that just didn't 

make sense to add to the core Outpost application, such as…
• Automatically poll a series of BBSs, one after another 

• Send the same message to several BBSs

• Detecting a text file on the PC and send it as a message to a BBS 

• Finding and doing something with a message that is received by Outpost 

2. Needed a different approach that would let users take advantage of the 
Outpost capabilities without… 
1. Over-complicating the Outpost program, and 

2. constraining the creative ideas that Outpost users have 
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A tour of Outpost Scripting
Recent Changes

What is Outpost Scripting
1. The means for users to write their own logic to manipulate the *entire* 

Outpost messaging environment

2. It is made up of 4 things:
• Outpost Scripting Language (OSL). A series of statements and commands 

that lets you develop your own messaging process flow based on your 
particular needs.

• Outpost Script Compiler. The OSL compiler reads the OSL script and 
produces a "virtual machine language" output for subsequent processing.  
When run, it reports either a Pass or a Fail. 

• Outpost Virtual Machine. Runs the compiled script. 

• Outpost Scripting Window. All scripting capabilities - editing, compiling, and 
running - are managed by the Outpost Scripts program called Opscripts.exe. 
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A tour of Outpost Scripting
Recent Changes

Outpost Scripting Language Capabilities
Best understood by spending time running through the tutorials located here… 
http://www.outpostpm.org/scripts

1. Basic introduction to scripts
2. OSL components
3. Playing with text strings
4. Arithmetic operations
5. Looping forever
6. Conditional looping
7. Other conditional operations
8. Send/Receive sessions
9. Creating messages (outside of Outpost)
10. Working with received messages
11. File Manipulation
12. Interacting with the outside world

http://www.outpostpm.org/scripts


The OSL statements
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The OSL statements
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The Opscripts.exe program

25 Packet Radio and Emergency Communications with Outpost

1. Single program that 
manages editing, compiling, 
and runtime monitoring

2. Scheduled from Outpost 
(Tools > Scripting) or 
double-click on the program.

3. When referencing BBSs or 
TNCs, they previously must 
be defined in Outpost!



Sample script #1
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SCRIPT 
‘ ***************************************************************** 
‘ Description: Loop on 2 BBSs. This script will continuously loop 
‘ on these 2 BBSs. To exit the loop, press the STOP button on 
‘ the Run Monitor Form. 
‘ Author: Jim KN6PE 
‘ Revision: 08/05/08 Original 

‘ ***************************************************************** 

BEGIN 
MYCALL = “KN6PE” ‘ check for my personal messages 
TNC = “GARAGE-TNC” ‘ use this TNC for all runs 

LOOP 
Print(CRLF & “Checking the K6FB-2 PBBS…”) 
BBS = “K6FB-2” ‘ check the Las Cumbres ARC PBBS 
RETRIEVE = “PB” ‘ retrieve Private and Bulletins 
SENDRECEIVE 

PAUSE(5) ‘ Pause 5 seconds… 

Print(crlf & “Checking the W6SJC-1 BBS…”) 
BBS = “W6SJC-1” ‘ check the San Jose RACES F6FBB BBS 
RETRIEVE = “PF” ‘ retrieve Private and Filtered msgs 
FILTER = “RACES:SCCNOR:SCCSOU” 
SENDRECEIVE 

PAUSE(600) ‘ Pause 10 minutes… 
ENDLOOP ‘ … then repeat 

END 



Sample script #2

27 Packet Radio and Emergency Communications with Outpost

SCRIPT 
‘ *************************************************************** 
‘ Description: Post a H&W message to the BBS every 4 hours 
‘ Author: Jim KN6PE 
‘ Revision: 08/05/08 Original 
‘ 
‘ *************************************************************** 

BEGIN 
MYCALL = “KN6PE” 
TNC = “GARAGE-TNC” 
BBS = “K6FB-2” 
RETRIEVE = “PB” ‘retrieve Private and Bulletins 

LOOP 
Print(crlf & “Creating and sending a H&W message…”) 
FROM = “KN6PE” 
TO = “W6TDM” 
SUBJECT = “H&W Check Message” 
MESSAGE = “Allan, system is still running. 73, Jim” 
MTYPE = “Private” 
CREATEMESSAGE

SENDRECEIVE 

PAUSE(60*60*12) ‘ Pause for 12 hours (60*60*12=14400 seconds) 
ENDLOOP

END 



Reports of Scripting applications
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Two ways that people are using Scripting

1. SoCal: 24 hospitals and EOCs registered in @winlink.org 
email with their tactical call signs. Once a month at home, 
user sends a message (via Telnet) with the tactical call signs 
so that Winlink.org won’t let them go dormant. 

2. Ontario: Has a RMS packet bridge and a number of other 
BBSs on the network; polls these nodes in turn.
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Outpost Scripting
Before you begin…

… a few things to consider
1. You must be familiar with setting up Outpost, creating messages 

and initiating Send/Receive Sessions with a BBS. 
2. Having some programming background helps, but is not required.  

Step through the entire Tutorial Series, enter all examples, and 
play with them; get creative!!!

3. OSL is not C++, Pascal, FORTRAN, Visual Basic, or any other 
language. You will see similarities as well as differences. 

4. Error handling will evolve. Most of the errors are trapped and 
reported, however, it is not yet 100% foolproof. 

5. Finally, OSL is evolving. If you have an idea that you think would 
further enhance the usefulness of Outpost Scripting, let me know.



30 Packet Radio and Emergency Communications with Outpost

6. Supporting the EOC
Recent Changes

Emergency Operations Center
• Central command and control facility 

responsible for emergency or disaster 
management functions

• Responsible for the strategic 
overview, or "big picture", of the 
disaster

• The first most critical component of an 
EOC is the individuals who staff it

• The second most critical component of 
an EOC is its communications 
systems

• Most municipalities use ARES/RACES 
groups for their primary or secondary 
communications channels
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ICS-213
General Message Form

• Originally designed as a multipart self-copying form for use 
as an interoffice memo.

• Increasingly used for messages between parties who are not 
in the same location. 

• The form is often originated in one location and transmitted 
electronically to another location.

• Replies are returned electronically and the two "parts" of the 
form are matched together.

• Incident messaging, message documentation, and 
transmission are being adapted to include emerging needs 
and best practices.

Source: http://ics213.com/
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Supporting the EOC
Recent Changes

If ICS-213 is what the OES uses, how do we tighten the 
alignment between what ARES/RACES Teams have to offer with 
their needs?

How do we support the passing of situational awareness 
information and strategic orders? 

What are the opportunities?

Adding an ICS-213 form to Outpost is one of the more 
frequent asked-for requests

However, everyone’s got an opinion on how ICS-213 should look



33 Packet Radio and Emergency Communications with Outpost

ICS-213
General Message Form

• Most ICS-213 Message 
Forms look like this…

Source: http://ics213.com/
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ICS-213
General Message Form

Multiple flavors

• One way, RACES variation

Source:
http://http://ronhashiro.htohananet.com/am-
radio/emcomm/
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ICS-213
General Message Form

Multiple flavors

• Header variation…

• Voice-net ready…
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ICS-213
General Message Form

Multiple flavors

• One way, detailed
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PacFORMS
Santa Clara County RACES

ICS-213 in Santa Clara County
• Santa Clara County OES 

required a backup means to 
pass RIMS messages; Packet 
Radio was the logical choice 

• County RACES also needed 
more standard means for 
soliciting and collecting 
information from the cities

• PacForms are web-based 
forms that can be deployed to 
the EOC staff for quick data 
entry

• Message can be saved to a file 
or passed directly to Outpost
using Opdirect MCS
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Opdirect MCS (Message Capture System)
Introduction

What is Opdirect.exe?

• An external program

• Listens for and receives 
messages from remote 
sources, such as SCC’s 
ICS-213, by a WinSock 
connection

• Processes and writes a 
message to the Outpost 
message DB

• Requires the Outpost 
Operator to complete 
the message and then 
press “send.” 

Listens to…
Host: LocalHost (127.0.0.1)
Port: 9334

Outpost-formatted
message

Outpost
Message DB



39 Packet Radio and Emergency Communications with Outpost

Opdirect MCS
Introduction

Starting Opdirect.exe

• From Outpost,
Tools > Message Settings,
Advanced Tab

• Currently, controls to schedule 
Opdirect.exe on Outpost startup
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PacFORMS and Opdirect MCS
Processing SCC’s online EOC Message Form

Outpost
Message DB

Outpost-formatted
message

Host: LocalHost (127.0.0.1)
Port: 9334

1

2

3 4
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PacFORMS and Opdirect MCS
Processing SCC’s online EOC Message Form

Outpost
Message DB

4
5

Auto-Open on
Message Receipt

3
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PacFORMS and Opdirect MCS
Implementation Details

• Opdirect.exe is part of the standard Outpost distribution

• Three forms are available (http://www.scc-ares-races.org/pfpublic/pacforms.html)
•ICS 213 Message form (Message.html)
•"City-Scan" Flash Report (city-scan.html, to report current status of the 
city after an emergency has happened)

•Logistics Request Form (logistics-request.html, to request logistics 
support from the county)

• Supports a “reverse read” capability to re-assemble the 
messages back into human-readable form

• Must be deployed on the same PC as Outpost for direct 
message integration with Outpost

• Can be deployed on a memory stick to the EOC Staff for 
message entry and file creation

http://www.scc-ares-races.org/pfpublic/pacforms.html


43 Packet Radio and Emergency Communications with Outpost

What’s next… 
Outpost v2.4
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What’s next… Outpost v2.4
other planned additions

1. Address book
• Distribution Lists

2. Scripting
• Startup automation; kick off a script when you first run Outpost
• Load and go: run a script directly from Outpost

3. various changes
• Clone BBS and TNC configs
• Node access to Xconnect, BBS commands
• Fix to 7 bugs, Adds ~15 enhancements

4. ICS-213 Message Maker
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ICS-213 Message Maker
What’s coming

• A generic ICS-213 general 
message form

• Supports local message 
management

• Message delivery to Outpost 
by Opdirect.exe

• Can exist anywhere on the 
same LAN as the Outpost 
PC
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ICS-213 Message Maker

Configuration Options

• File > Properties…

• Formatting… set date, time and 
From: and To: defaults 

• Browsing… lets you look for a 
message saved, sent, or 
received.

• Remote Access… the network 
parameters describing where 
to find Outpost
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ICS-213 Message Maker
Processing an ics213mm message

Pressing New…

• Fills in the defaults… 
To:, From:, Date, and Time

• Sets the Signature to the Sender 
(From:), can be changed

• You fill in the…
• Subject
• Message
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ICS-213 and Opdirect MCS
Processing an ics213mm message

Pressing Save/Send…

Outpost
Message DB

Outpost-formatted
message

Looking for Opdirect.exe at:
Host: LocalHost (127.0.0.1)
Port: 9334

1

3
4 5

1

2
ICS213

Message 
DB
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ICS-213 and Opdirect MCS
Processing an ics213mm message

Outpost
Message DB

5
6

Auto-Open on
Message Receipt

4
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ICS-213 and Opdirect MCS
Summary

Features
• Keeps the focus on the message
• Originates new messages
• Receives new messages and create replies
• Produces a readable ICS213 message outside of Outpost
• Deployable anywhere on the same LAN as Outpost
• Supports multiple remote instances

Barriers
• Some Municipalities do not allow PCs on their network that are connected 

to an external network (Packet?!?!!) or that are not owned PCs (RACES)
• If your packet machine is on the EOC LAN, congratulations!
• If not…consider your own EOC/Radio Room LAN/subnet
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ICS-213 and Opdirect MCS
Leveraging Local Area Networks

Wi-Fi capable residential gateway / 
router

• The device is capable of sharing Internet 
connections among several computers via 
802.3 Ethernet and 802.11b/g wireless data 
links.

• Look for one with wired and wireless (need 
to be wired to configure)

• Can co-exit with other wireless environments

• Configure with a unique SSID (Network 
name, i.e.: CARESEOC)



Need more information?
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•User Guide… www.outpostpm.org#documentation
• A complete description of all features, forms, fields, and controls in Outpost

•HOW-TO pages… www.outpostpm.org/howto.html
• Specific How-To’s for the most common tasks performed

•Application Notes… www.outpostpm.org#documentation
• Write-ups with more details on a specific topic.

•Troubleshooting page… 
www.outpostpm.org/troubleshooting.html

•Users group… 
http://groups.yahoo.com/group/outpostpacket/
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Thank you
Any Questions?
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